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Preface

Rational ClearQuest Project Tracker allows you to exchange information
between the Microsoft Project 2000 project management application and
Rational’s ClearQuest change management system. It helps you create

a comprehensive “closed loop” project tracking system that takes full
advantage of the project management features of Microsoft Project 2000 and
the change management capabilities of Rational ClearQuest.

With Rational ClearQuest Project Tracker, the project manager has easy access
to information in ClearQuest about work being performed by individual
contributors. The project manager can feed this information into Microsoft
Project 2000 and accurately update the project plan with the most up-to-date
information available.

With Rational ClearQuest Project Tracker, information from new and updated
project plans can be transferred to Rational ClearQuest and made available to
individual contributors and team managers. The contributors can adjust their
priorities and schedules based on the most up-to-date project plan dates.

Creating this closed loop project tracking system ensures that individual
contributors are focused on the plan and that the project manager gets
accurate information on the progress being made. As a result, Rational
ClearQuest Project Tracker saves time, reduces wasted efforts, and helps
bring projects in on schedule.

This guide also provides information on how to use Microsoft Project project
plans based on the Rational Unified Process (RUP). If you have the Rational
Unified Process available on your system, you can access the RUP project
plans from Rational Unified Process > Templates > Microsoft Project.

These plans reinforce the best practices methodology developed by

Rational Software.

Vi



Audience

This document is intended for project managers and staff of organizations
that are using Rational ClearQuest for change request management, and that
are using or planning to use Microsoft Project 2000 for project management.

For systems administrators, Appendix A explains how to set up and
configure Rational ClearQuest Project Tracker. The system requirements for
using Rational ClearQuest Project Tracker are also included in this appendix.

Appendix B discusses how to access and apply the optional RUP project plans
to Rational ClearQuest Project Tracker.

Before you begin

If you are a project manager who has not used Rational ClearQuest,
read the following:

Introducing Rational ClearQuest
An overview of Rational ClearQuest components and how to use them.

If you are a system administrator administering Rational ClearQuest, you
should have read:

Installing Rational ClearQuest
A guide on how to install Rational ClearQuest and related software.

Administering Rational ClearQuest
A guide on how to customize Rational ClearQuest.

Rational ClearQuest Release Notes

(\\Program Files\Rational\ClearQuest\readme.htm)

An HTML file that includes the most recent systems requirements
information.

Audience vii



Contacting Rational Software

If you have a technical problem and you cannot find the solution in this
guide, contact Rational Software Technical Support. From a Help screen

in Rational ClearQuest, click Help and select Help Topics >

Contacting Rational for addresses and phone numbers of technical support
centers.

For technical information about Rational ClearQuest, answers to common
guestions, and information about other Rational Software products, visit the
Rational Software World Wide Web site at http://www.rational.com. To contact
technical support directly, use http://www.rational.com/support.

Contacting Rational Software viii



Overview of
Rational ClearQuest
Project Tracker

This chapter provides an overview of Rational ClearQuest Project Tracker.

It outlines the benefits of using Rational ClearQuest Project Tracker, describes
the capabilities of the product, and provides two scenarios showing how the
software might be used to exchange information between a project manager
and the individual contributors and team managers working on a project.

What is Rational ClearQuest Project Tracker?

Rational ClearQuest Project Tracker is a Microsoft Project 2000 add-in,
a software module that can be used to add additional Rational ClearQuest
functionality to Microsoft Project 2000.

With Rational ClearQuest Project Tracker, you can export tasks from a
Microsoft Project 2000 project plan to automatically create new database
records in Rational ClearQuest. The tasks are automatically linked with these
new database records. You can then synchronize the corresponding tasks and
records later in the project, so that changes made in one system can be
automatically reflected in the other.

You can also import records from Rational ClearQuest to create new project
plan tasks in Microsoft Project 2000. These records and tasks are also linked so
that you can continue to synchronize them periodically. In this way, progress
reported in Rational ClearQuest can be transferred automatically to Microsoft
Project 2000, so that a project manager can always update the project plan
with the most accurate and up-to-date information.

Creating a closed loop project tracking system

By using Rational ClearQuest Project Tracker, you can take full advantage of
both project management and change management systems to create a closed
loop project tracking system.



A project manager can use a project management tool, Microsoft Project 2000,
to create a high-level project plan. The plan specifies the major tasks that
make up a project. It also identifies dependencies between the tasks, planned
start and completion dates for the tasks, and other planning data. The project
manager can update the plan as tasks are completed, resources are added or
lost, or other factors change.

A change management system, such as Rational ClearQuest, allows both
managers and individual contributors to enter new change requests for a
project, including requested enhancements, defects and documentation.
They can also modify and close existing change requests, share information
with each other, and create queries and reports to track individual change
requests and the overall progress of the project.

However, using a project management tool and a change request system
together can be extremely difficult. Under typical conditions, an immense
amount of manual effort is required to keep corresponding tasks and records
synchronized and up-to-date.

For example, if a project manager wants to update a project plan during the
course of the project, the manager has to identify all of the new and modified
change requests entered in the change management system by many different
contributors.

Figurel  To keep a project plan updated, information must be obtained
from many contributors. Rational ClearQuest Project Tracker makes it easy
to keep corresponding tasks and records synchronized.

Project Plan ClearQuest DB
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After the project manager collects all of this information, the manager must
manually re-enter the data as new or modified tasks in the project
management tool. Not only is this process time-consuming and error-prone,
but the information is likely to be outdated before it can all be captured and
entered.

With Rational ClearQuest Project Tracker, you will be able to automate most
of the integration of information between Microsoft Project 2000 and the
ClearQuest change management system. This saves the project manager time
and makes sure that everyone on the team can work from accurate,
up-to-date information and plans.

The result is a closed loop project tracking system, where actual results and
other input from individual contributors and managers working on the
project can be fed into the project plan, while changes in the project plan are
transmitted back to the individual contributors.

Figure2  Creating a closed loop project tracking system

Actual Results
and Contributor Input

Project Plan ClearQuest DB
Task Fecord
Task Fecord
Task Fecord

Plan Revisions
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Capabilities of Rational ClearQuest Project Tracker

Rational ClearQuest Project Tracker provides a number of capabilities that
automate the integration of a project plan created in Microsoft Project 2000
with a project database created by Rational ClearQuest, such as:

Linking a project plan with a database

When you first set up a Microsoft Project 2000 project plan to work with
Rational ClearQuest Project Tracker, you create an association between that
project plan and a corresponding ClearQuest database. This may be an
existing database related to the same project as the project plan, or a new
database just created for the project. The link ensures that future imports,
exports, updates and synchronizations are always performed against the
same database. More information on linking is provided in Chapter 2, Linking
a project plan with a ClearQuest database.

Importing ClearQuest records to create new
Microsoft Project tasks

In Microsoft Project 2000, tasks are the building blocks of a project plan.
Similarly, each record in the ClearQuest database represents an activity that is
a necessary part of a project. When Microsoft Project 2000 and Rational
ClearQuest are both used to plan and track activities for the same project, in
most cases each project plan task will correspond with a single record in the
Rational ClearQuest database.

With Rational ClearQuest Project Tracker, you can create new tasks in a
project plan from records in a ClearQuest database using the Import New
Records from ClearQuest function. Fields in the newly created task are
initialized from the ClearQuest record. The record and the task are
automatically linked, so that future changes to one will be reflected in the
other when the project plan and the ClearQuest database are synchronized.
More information on importing is provided in Chapter 3, Importing records
from ClearQuest.

4 Using Rational ClearQuest Project Tracker



Exporting Microsoft Project tasks to create
Clearquest records

With Rational ClearQuest Project Tracker, you can also take tasks in the
project plan and use these to create new records in a ClearQuest database
using the Export New Tasks to ClearQuest function. Fields in the newly created
ClearQuest record are initialized from the project plan task. The task and the
record are automatically linked, so that future changes to one will be reflected
in the other when the project plan and the ClearQuest database are
synchronized.

Figure3  The Import function creates new project plan tasks from
records in ClearQuest. The Export function creates new records in
ClearQuest from tasks in the project plan.

Import

Project Plan ClearQuest DB
Task Fecord
Task Fecord
Task Fecord

Export
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Note, however, that Rational ClearQuest Project Tracker will only create new
records in the ClearQuest database for non-summary tasks in the project plan.
Summary tasks, which represent an overall description of a collection of
specific work steps, do not typically have a corresponding record in the
ClearQuest database. Similarly, Rational ClearQuest Project Tracker does not
create database records for milestones, which indicate the completion of a
project phase but do not represent a task in themselves.

More information on exporting is provided in Chapter 4, Exporting tasks
Microsoft Project 2000.

Updating and synchronizing a project plan with
a ClearQuest Database

Over the course of a project, changes may be made in project plan by the
project manager, and in the ClearQuest database by team managers and
contributors. Rational ClearQuest Project Tracker provides update and
synchronize capabilities, so that changes to ClearQuest database records are
reflected in the linked project tasks, and changes to project tasks are reflected
in the linked ClearQuest database records.

Figure4  The Update function updates project plan tasks from

ClearQuest. The Synchronize function performs a bi-directional transfer of
information between linked records and tasks.

Update

Project Plan ClearQuest DB

Synchronize

6 Using Rational ClearQuest Project Tracker



With Rational ClearQuest Project Tracker, you can update the project plan by
copying information from records in the ClearQuest database to linked tasks
in the project plan. This keeps the project plan up-to-date by transferring
information that was entered into ClearQuest by the individual contributors
and managers working on the project.

Note that the Import function discussed earlier uses new ClearQuest records
to create new Microsoft Project tasks, while in contrast the Update function
works with existing records and tasks that have already been linked.

You can also synchronize the project plan and the database. This involves a
two-way flow of information (compared to the one-way transfer used in the
update process).

First, information is copied from records in the ClearQuest database to linked
tasks in the project plan. Second, information is copied from tasks in the
project plan to linked records in the ClearQuest database.

At the end of this process, the project plan and the ClearQuest database are
synchronized, with the same information included in every pair of linked
tasks and records. Not only does the project manager have the most
up-to-date information from the individual contributors, but the contributors
have the most up-to-date data from the latest project plan.

Note that the Export function discussed earlier uses new Microsoft Project
tasks to create new ClearQuest records, while in contrast the Synchronize
function works with existing tasks and records that have already been linked.

During the Synchronize process, potential disagreements or conflicts are
resolved through a set of rules. For example, planned start and planned
completion dates are resolved in favor of the entries in the Microsoft Project
task. This is because planned dates are typically driven by the project
manager who creates the project plan.

On the other hand, actual start and actual completion dates are resolved in
favor of the entries in the ClearQuest record, because accurate, actual dates
are entered into the ClearQuest database by the individual contributors who
perform the work.

Also, a log file is available to help you track updated information and if
necessary, reverse changes.

The update and synchronization processes are discussed in more depth in
Chapter 5 of this guide.

Capabilities of Rational ClearQuest Project Tracker 7



Using the RUP project plans

The Rational Unified Process (RUP) provides a best practices methodology
for software development projects. RUP makes available a set of Microsoft
Project plans that organize tasks according to the best practices methodology.

You can use these plans as the starting point to create and customize project
plans that reinforce RUP. When the project plans are complete, you can use
Rational ClearQuest Project Tracker to create records in a ClearQuest
database that correspond to the tasks in the project plan.

If you have the Rational Unified Process available on your system, you can
access the RUP project plans from Rational Unified Process > Templates >
Microsoft Project. The RUP project plans are discussed in more depth in
Appendix B of this guide.

8 Using Rational ClearQuest Project Tracker



Scenario 1: Starting with a new project plan

Figure 5 illustrates a typical scenario for using Rational ClearQuest Project
Tracker. At the beginning of this scenario, the project has not yet begun. The
project manager will create a new project plan, then use that plan to create a
new ClearQuest database. Ongoing changes to the database will then be
transferred to the project plan, and changes to the project plan will be
transferred to the database.

Task - Changed *

hr Record - Change}

Figure 5 Steps for integrating a new project plan with ClearQuest
Project Team Individual
Manager Managers Contributors
1. Create
detailed
ject pl
project plan 2. Create new datahase
Project Plan and |i:‘hk§r?jzm plan  IClearQuest DB
Task wi alabhase Record
Task * F Record
3. Export tasks to create
ClearQuest records
4. Add/modify
ClearQuest
records
Project Plan | 3. Importnew records  |[ClearQuest DB
from ClearQuest to
create new tasks __ [mecord |
MewTask || g Lpdate existing tasks |HewRecord |
from existing ClearQuest
7. Add/modify records
project plan
tasks 8. Export new tasks to
iject Plan create new ClearQuest ClearQuest DB
records
-

Eew Task

9. Synchronize existing
records with existing
tasks

All of the Rational ClearQuest Project Tracker functions described in this
scenario are available in Microsoft Project 2000 under the Tools>ClearQuest
menu.

Scenario 1: Starting with a new project plan
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Scenario 2: Integrating a project plan with an existing
ClearQuest database

Figure 6 illustrates another typical scenario for using Rational ClearQuest
Project Tracker, when a project plan and a ClearQuest database were created
independently for the same project.

Figure 6  Steps for integrating an existing project plan with ClearQuest

Project Team Individual
Manager Managers  Contributors

1. Link project plan and
Project Plan ClearQuest database ClearQuest DB

= a— -
Record

2. Import datahase
records to create new
project plan tasks

Project Plan ClearQuest DB
Tazk N Record
3. Export project plan
— tasks to create new
== database records
4. Add/modify
ClearQuest
records

5. Import new records
Project Plan from ClearQuest to
ask - Changed create hew tasks Record - Changead
Record

6. Update existing tasks |[Record

s Task from existing Nevws Record

‘ ClearQuest records

= [
wffw
==

7. Add/modify
ject pl
prﬂjtzsk;l an 8. Export new tasks

- to create new
Project Plan ClearQuest records

= | & o
o o
2 3
=3 =
z H
T
8 @
= =
m =}

ecord - Changed
[T2sk-Ehanged | Record - Changed
9. Synchronize Record - Changed
existing records ewr Reoord

with existing tasks
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The project manager will import ClearQuest database records to create new
project plan tasks, then export Microsoft Project project plan tasks to create
new database records. Ongoing changes to the database will then be
transferred to the project plan, and changes to the project plan will be
transferred to the database. Again, all the Rational ClearQuest Project Tracker
functions described in this scenario are available in Microsoft Project 2000
under the Tools>ClearQuest menu.

In Step 1, the project manager (or the ClearQuest administrator) links the
project plan with the existing ClearQuest database using the Link to
ClearQuest Database function.

This particular function is generally a one-time procedure and is only applied
when a new project plan is created. Once a project plan is linked with a
ClearQuest database, their association remains permanent unless problems
occur with the ClearQuest database. Make sure to contact the ClearQuest
administrator if there seems to be difficulties with the ClearQuest database.

In Step 2, the project manager uses the Import New Records from ClearQuest
function to create new tasks in the project plan from existing ClearQuest
database records.

In Step 3, the project manager uses the Export New Tasks to ClearQuest function
to create new ClearQuest database records from existing project plan tasks. At
this point, all of the tasks in the project plan (excluding summary tasks and
milestones) are linked with corresponding records in the ClearQuest
database.

In Step 4, team managers and individual contributors modify records in the
ClearQuest database to record progress on actual work, and add new records
so they can track previously unplanned work.

In Step 5, the project manager uses the Import New Records from ClearQuest to
automatically create new tasks from ClearQuest records that have been added
to the database.

In Step 6, the project manager uses the Update Plan from ClearQuest function
to update existing project plan tasks based on changed records in the
ClearQuest database.

In Step 7, the project manager adds new tasks and modifies existing tasks in
the project plan.

In Step 8, the project manager uses the Export New Tasks to ClearQuest to
automatically create new ClearQuest records from new tasks that have been
added to the project plan

Scenario 2: Integrating a project plan with an existing ClearQuest database 11



In Step 9, the project manager uses the Synchronize Plan with ClearQuest
function to automatically update existing ClearQuest database records based
on changed tasks in the project plan.

As in the previous scenario, Steps 4 through 9 can be repeated iteratively over
the life of the project.

How team members create records in a ClearQuest database

Before moving on to the next chapter, let’s look for a moment at how
individual contributors and managers create records in a ClearQuest
database. This will help you understand further how information is
exchanged between Microsoft Project 2000 and Rational ClearQuest. If you
are already familiar with ClearQuest, you should proceed to Chapter 2,
Linking a project plan with a ClearQuest database.

Team members create records by entering data in forms generated by
ClearQuest. The records are stored in the ClearQuest database. The forms are
made up of tabs and fields that vary according to the type of activity being
tracked.

The Main and Schedule windows that follow are examples of the two
ClearQuest forms used for submitting information to ClearQuest Project
Tracker.

Figure7  The ClearQuest Main form

B tain | Schedule

Headiine |

Description ;I
=

Owner j
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Figure8  The ClearQuest Schedule form

B Main Schedule |

~ Planned

Start D ate I J Diuration I
End Date I J Fiemaining Duration I

ok, I Femaining ‘ork I

—Actual
Start D ate I J
ork, ||
End Date I J

Note that these forms can be customized for your environment by your
ClearQuest administrator. As a result, the forms for your organization’s
ClearQuest system may differ from these examples, with possibly, different
fields and different names on the fields or the tabs.

The Main form includes the Headline, Description and Owner fields. The
Schedule form is divided in two sections and includes fields for planned and
actual dates.

The Planned section in the Schedule form includes mostly read-only fields
that store scheduling data provided from the project plan. The Actual section
contains data which is provided and updated by the team member using
ClearQuest.

When the project manager imports records from ClearQuest to create new
tasks, information entered in the records’ Main form and in the Actual section
of the Schedule form is copied over into the project plan.

When the project manager exports tasks to create new records in ClearQuest,
information is copied into the records’ Main form and into the Planning
section of the Schedule form. The import and export processes are covered in
detail in Chapter 3, Importing Records from ClearQuest and in Chapter 4,
Exporting Tasks from Microsoft Project 2000.

How team members create records in a ClearQuest database 13



ClearQuest also assigns a unique identification (ID) number for every record.
When a record in ClearQuest or a task in Microsoft Project 2000 are created
using Rational ClearQuest Project Tracker, a unique ID is assigned. This ID is
used to link the ClearQuest record with its associated project plan task, so that
information continues to be exchanged between them when the project
manager uses the update or synchronize processes discussed further in
Chapter 5, Updating and Synchronizing.

14 Using Rational ClearQuest Project Tracker



Linking a project plan
with a ClearQuest
database

This chapter tells you how to link a Microsoft Project plan with a ClearQuest
database so that you can exchange information between them.

You only go through this process the first time you want to exchange
information between a project plan and a ClearQuest database. After the link
has been established, ClearQuest Project Tracker will always exchange
information between the linked project plan and the linked ClearQuest
database.

Also, you can only link a project plan to one ClearQuest database. Once a link
has been made it cannot be removed.

Figure9  Linking a project plan with a database

Project Plan I_ IN k ClearQuest DB
h

Note that before you can use Rational ClearQuest Project Tracker, a number of
installation steps must be carried out by your ClearQuest administrator.
These steps are described in Appendix A.

You may want your ClearQuest administrator to work with you the first time
you go through this process, so that you both can make sure that all of the
prerequisites have been met and that the everything is working properly.

15



Selecting the ClearQuest database

The first step in linking a Microsoft Project 2000 project plan with a
ClearQuest database is to open your project plan and select the correct
database.

To select a ClearQuest database:
1 Open the Microsoft Project project plan.

2 From the Tools>ClearQuest menu, select Link to ClearQuest Database.
The ClearQuest Login window displays.

3 Log on to the appropriate ClearQuest database by providing your user
name, password, and the ClearQuest database name and then click OK.
This establishes which ClearQuest database will be associated with the
project plan.

Figure 10 Rational ClearQuest Login window
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Choosing fields to store ClearQuest data

Once you have selected the ClearQuest database, the Assign Custom Fields
window automatically displays. This window allows you to establish which
fields in Microsoft Project 2000 will be used to store ClearQuest-related data.

Microsoft Project 2000 ships with several extra fields predefined precisely to
allow users and tool vendors to enhance the functionality of the application.
These fields are labeled Textl, Text2, etc. You must select three of these fields
to be used by Rational ClearQuest Project Tracker. You should pick three that
are not already being used for your project by some other integration with
Microsoft Project.
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In the Assigns Custom Fields window, choose the project plan fields to store
ClearQuest related data by clicking in succession on three unused fields
and, then click OK.

Figure 11  Assign Custom Fields window

. Assign Custom Fields 10l =|

Clearluest Project Tracker requires that you assign three ak.
cuztom T ask fields for the integration with Microsoft Project.

Fleaze zelect three (3] from the Available Fields list. Cancel

Awailable Fields Azszigned Fields

T8 i N I
Texts Text2
Texth Textd
Text?
Textd

Configure your view inside Microsoft Project 2000
to display ClearQuest related data

After selecting the Microsoft Project fields used to store ClearQuest-related
data, you will be prompted to add columns to your Microsoft Project 2000
view. This is a standard Microsoft Project operation, described in the online
help for Microsoft Project 2000.

To add columns to your Microsoft Project 2000 view:
1 Selectacolumn that is already in the view.

The new columns will be added in front of this selected column. We
suggest selecting the third column, so that the new fields appear
immediately after the Task Name column.

2 From the Insert menu, select Insert Column or right click on the column
heading and select Insert Column from the pop-up menu.

The Column Definition window displays, prompting you to select a field
for the new column.

Configure your view inside Microsoft Project 2000 to display ClearQuest related data 17
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Figure 12 Column Definition window
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3 Specify the Field name, CQ Record, and click OK.
A new column will appear in the project plan with the title, CQ Record.

4 Repeat these steps to add a column for the CQ Type field. The project plan
will now display the CQ Record and CQ Type columns.

Figure 13 CQ Record and CQ Type columns in project plan
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Note: You can easily remove (“hide”) a column in much the same way — see
Microsoft Project 2000 online help for further instructions.
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Updating the ClearQuest Record Types

Before you are ready to start exchanging data between ClearQuest and
Microsoft Project 2000, you need to establish which ClearQuest record types
will be available.

From the Tools>ClearQuest menu, select the Updating the ClearQuest
Record Types List and click OK.

This function will discover which record types have been enabled for use
with Rational ClearQuest Project Tracker (by virtue of having the appropriate
ClearQuest packages applied to the record types).

Figure 14 Updating ClearQuest Record Types List

& Updated ClearQuest record bypes list.

This function populates a list of values available for the CQ Type field inside
Microsoft Project 2000 and ensures that the values are accurate. The value of

this field controls, which kind of ClearQuest record should be created, for the
given Microsoft Project 2000 task.
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Importing records from
ClearQuest

This chapter tells you how to import records from a ClearQuest database to
create new tasks in a project plan.

Figure 15 Importing records from ClearQuest
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The chapter describes the basic steps for importing ClearQuest records into
the project plan. It explains how to create and use queries that select exactly
which ClearQuest database records you want to import. The chapter
concludes with how to save and review log files created during the import
process.

The next chapter will describe the inverse process of exporting tasks from a
project plan to create new records in a ClearQuest database.

As noted in the first chapter, the Import function uses new ClearQuest records
to create new Microsoft Project tasks, while in contrast the Update function
works with existing records and tasks that have already been linked. The
Update function is discussed in Chapter 5, Updating and Synchronizing.
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Accessing Rational ClearQuest Project Tracker
from Microsoft Project 2000

After Rational ClearQuest Project Tracker has been installed and you have
opened Microsoft Project 2000, you can access the main functions by clicking
the Tools menu and pointing to ClearQuest. The main functions are:

Figure 16 Menu items for Rational ClearQuest Project Tracker
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Importing records from a ClearQuest database

With the import process, you can create a new project plan quickly by
building on the detailed information available in a ClearQuest database,
or you can automatically add new tasks to an existing project plan.

To create new project plan tasks from ClearQuest records:
1 Launch Microsoft Project 2000 and open the project plan.

2 From the Tools>ClearQuest menu, select Import New Records from
ClearQuest.

The Select Records to Import window displays. This window allows you
to select an existing query against the ClearQuest database or to create a
new query (see section on Creating and Using Queries). When you execute
a query, Rational ClearQuest Project Tracker displays the query results
from the ClearQuest database.

Note: If the Rational ClearQuest Login window displays instead, you will
need to associate the project plan with the ClearQuest database. These
steps are described in Chapter 2, Linking the Project Plan with the ClearQuest
Database.

3 When you have located or created the desired query, click Run to execute
the query against the ClearQuest database. The results of your query then
displays.
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5

If you want to review a particular record before importing it into your
project, Rational ClearQuest Project Tracker allows you to access the actual
record forms stored in the ClearQuest database. Simply double-click on
the record listed in the Select Records to Import window. Close the
record’s window to continue importing.

Select the records you want to import and click OK.

Figure 17 Selected ClearQuest records for import
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Note: Make sure to highlight the records you want to import,
Rational ClearQuest Project Tracker imports only the selected ClearQuest
records.

The Import New ClearQuest Records To MS Project Plan Tasks window
then displays. It allows you to start the import process.

Click Start.

The Import New ClearQuest Records To MS Project Plan Tasks window
lists the tasks being created as the records are being copied over from the
ClearQuest database. The Progress window lists the ID and name of each
record being imported.
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Figure 18 Creating tasks from ClearQuest records
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7 Click Close when you are finished importing and want to return
to your project plan.
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Matching Resources with ClearQuest Users

During the Import process, Rational ClearQuest Project Tracker will check
each ClearQuest record to see that the entry in the Owner field (sometimes
called the ClearQuest user field) matches one of the Resource names already
in use in the project plan. If it encounters an Owner name in a ClearQuest
record that is not in use in the project plan, it will interrupt the import process
and display the Select Resource Matching CQ User window.

Figure 19 Select Resource Matching CQ User window
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If you see a Resource name that is equivalent to the Owner field in the linked
ClearQuest record, select that name from the list and click Change Resource
Name. For example, if the ClearQuest user is “lead,” and you know that “QE
Manager” is the equivalent name in the project plan, select “QE Manager”
and click the Change Resource Name.

When you select to change the Resource Name, Rational ClearQuest Project
Tracker will replace the entry, that was in the Owner field of the ClearQuest
database record, into the Resource name field of the project plan task. It will
not use the Resource name you selected in the Select Resource matching CQ
user window.

In the example above, this means it would place “lead” in the Resource name
field, even though you selected “QE Manager” before clicking Change
Resource Name.
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It may seem counter-intuitive that the project plan’s Resource name is
changed, but this has to be done because:

= at the end of the process, the Owner field in the database record and the
Resource name field in the project plan task must have the same entry;,

and the Import process can’t change the value in the ClearQuest database.

In this situation, Rational ClearQuest Project Tracker will also change the
Resource name in the list of valid Resource names (in this example from “QE
Lead” to “admin”). You can see this from the Tools>Resources menu and
selecting the Assign Resources option.

This change is made to make sure that the same Resource hame (“admin”)
will be used consistently for future tasks and records in both the project plan
and the ClearQuest database.

If you do not see a matching resource name, you can select Create Resource.
Rational ClearQuest Project Tracker will fill in the Resource name field in the
project plan task with the entry that is in the Owner field of the ClearQuest
Record. It will also add the new entry to the list of Resource names used in the
project plan. Again, you also can see this list by looking at the
Tools>Resources menu and selecting Assign Resources.

If you click Create All Resources, then Rational ClearQuest Project Tracker
will automatically fill in the Resource name field in the project plan task with
the entry that is in the Owner field for all of the other ClearQuest database
records that are being imported.

Figure 20 Warning on creating all resources
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Rational ClearQuest Project Tracker will not display the Select Resource
matching CQ user window again during that import process. Before clicking
the Create All Resources function, you should make sure that you do not want
to use the Change Resource Name function for any other record that you want
to import.
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Saving and viewing the log file

As Rational ClearQuest Project Tracker imports the ClearQuest records, it
creates a progress log listing each record and the value of each field that is
transferred.

You can save the log as a Rich Text Format (.rtf) file and review it to make sure
that all of the information that was imported is appropriate and in the correct
format for your project plan. You can open the saved file using any type of
text editor or word processor.

It is also a good idea to keep all log files in their own folder in case questions
arise about tasks created by the import process.

To save and read the progress log file, click Save Log in the Import New
ClearQuest Records To MS Project Plan Tasks window and specify the
filename and directory path for the log file.

Figure 21 Saving progress log
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Viewing the new tasks in the Microsoft Project project plan

As Rational ClearQuest Project Tracker imports the records selected by the
guery into the project plan, it creates new project tasks. Information from the
following ClearQuest fields is copied over to create a corresponding project
plan task:

»  Task Name/Headline

= Assigned Resource

= Actual Work
Planned Work
Remaining Work
Actual Start Date

= Actual Finish Date

When Rational ClearQuest Project Tracker finishes converting the ClearQuest
records, you will see the newly-created tasks at the end of the project
plan.You can re-position the new tasks anywhere inside the project plan as
long as they remain non-summary tasks.

The new tasks include a CQ Type value. This value describes the type of
record that was imported as defined in ClearQuest, for example Defect or
Enhancement.

The project plan is now updated to reflect the new tasks imported from the
ClearQuest database.
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Creating and using queries for imports

A query is a request to retrieve database records that meet specified criteria,
for example all records of a certain type, or all records where the value in a
field equals or exceeds a specified value, or all records that were created after
a certain time.

Rational ClearQuest Project Tracker allows you to:

* Run aquery that you created in the past

* Run a public query created by someone else

= Modify and run an existing query, either one you created or a public query
= Create and run a new query using the ClearQuest Query Wizard

The queries used by Rational ClearQuest Project Tracker are exactly the same
as normal ClearQuest queries, and in fact may be queries created earlier using
ClearQuest. If you are not familiar with the process of creating and using
database queries, you should review the Introducing Rational ClearQuest
guide. More information on executing a query is provided by accessing the
online Help in Rational ClearQuest.

Figure 22 The ClearQuest Query Wizard guides you in creating queries
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When you select Import New Records from ClearQuest from the
Tools>ClearQuest menu, you will see a ClearQuest query window.

The Workspace section on the top of the window allows you to select
personal queries that you created previously or existing public queries that
were created by the system administrator or someone else and were made
available to you and others using the system.

You can select an existing personal or private query and then click on Run to
execute the query. If you want to see the criteria used to create the query
before you run it, click on Edit. When you have created or selected the query,
click on Run to have it execute. As noted earlier, Rational ClearQuest Project
Tracker will display the records retrieved from the ClearQuest database by
your query.

Saving a master copy of the project plan

It is strongly recommended that you keep a secure master copy of the last
official version of the Microsoft Project project plan and always use this
master copy for importing, exporting and other Rational ClearQuest Project
Tracker functions.

In some situations, you may want to distribute several copies of the project
plan, perhaps to multiple project managers. However, you can not safely
export records from each of these copies to the ClearQuest database, because
changes in one copy of the project plan may conflict with changes in another
version. The lead project manager must take the responsibility of integrating
changes from all sources into the master copy of the project plan and using
this master copy to export to the ClearQuest database.

The same logic applies to the other functions of Rational ClearQuest Project
Tracker. Keep a secure master copy of the project plan, integrate all changes
into this copy, and make sure that all importing, exporting, updating and
synchronizing are carried out between this version of the project plan and the
ClearQuest database.
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Exporting tasks from
Microsoft Project 2000

This chapter describes how to export tasks from a project plan to create new
records in a ClearQuest database.

Figure 23  Exporting tasks from the project plan into ClearQuest
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The chapter also discusses how to save and review log files created during the
export process. It concludes with notes about how certain fields in your
project plan and ClearQuest database are affected by the export process.

As noted in the first chapter, the Export function uses new Microsoft Project
tasks to create new ClearQuest records, while in contrast the Synchronize
function works with existing tasks and records that have already been linked.

The Synchronize function is discussed in Chapter 5, Updating and
Synchronizing.
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CQ Record Types and required fields

Before we describe the Export process, it is useful to understand CQ Record
Types and the concept of required fields for ClearQuest records.

When you export project plan tasks to create new ClearQuest database
records, you must select a CQ Record Type for each new record.

Depending on the record type selected, you may also need to enter values in
additional required fields for that record type. For example, if you are
exporting a task and you select Enhancement Request as the CQ Record Type,
you will need to enter a customer name and a customer priority for that
record. In order to enter the information, you will use a series of ClearQuest
forms, known as submit forms.

Individual contributors and team managers working with ClearQuest use the
CQ record type and required fields to find and analyze records in the
database. For example, a manager might want to create a report of all of the
recent enhancement requests, and sort the requests by priority. This is only
possible if, during the Export process, you have identified tasks that represent
enhancement request as EnhancementRequest record types and make an
entry (High, Medium or Low) in the Customer Priority field.

Exporting tasks from a project plan to create
ClearQuest records

32

Tasks from a project plan can be exported from Microsoft Project 2000 to
create new records in the ClearQuest database. This allows you to:

Add new records to a ClearQuest database based on information in a
project plan.

Keep the ClearQuest database continuously updated based on new tasks
added to the project plan during the life of the project.

To export the project plan tasks:
1 Launch Microsoft Project 2000 and open the project plan.

2 Inthe CQ Type field for a particular task, select a valid record type from
the list. Repeat this for each task you want to export.

Using Rational ClearQuest Project Tracker



Figure 24 A single task with CQ Type EnhancementRequest
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Highlight the tasks that you want to export to the ClearQuest database.

Make sure to select the tasks you want to export,
Rational ClearQuest Project Tracker only exports the selected tasks.

From the Tools>ClearQuest menu, select Export New Tasks
To ClearQuest.

The Export New Project Plan Tasks to ClearQuest window displays.

Figure 25 Export New Project Plan Tasks To ClearQuest window
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Click Start.

If there are required fields for any of the record types that you are
exporting, Rational ClearQuest Project Tracker displays a message asking
if you want to add data to the new record being created.

If you click No, the task will not be exported to the ClearQuest database
(although it will remain in the project plan).

If you click Yes, Rational ClearQuest Project Tracker displays the forms
used in ClearQuest to submit and modify data for that record type.
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Figure 26 Required Fields window
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7 On the ClearQuest forms, tabs that include a required field will be marked

by a red square. The names of the required fields will be highlighted in
red.

Click on each of the tabs with a red square, then make an entry in each
required field. You can also enter information on the other fields on these
forms if you know the correct information.

Figure 27 ClearQuest Submit Forms
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8 When you have completed the required fields for all of the tasks being
exported, Rational ClearQuest Project Tracker will begin the export

process and displays the name of each task being exported in the Progress
window.

9 Click OK to save the changes to the ClearQuest database and to your
project plan.
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Figure 28 Displaying all logged information in Progress window

i, Export New Microsoft Project Plan Tasks To Clearfuesk

Add tips to Installation Guide Sitark

Cloze

J

Hew walue: 4 days
Copying M3P field Task Remaining Duration to CQ field am planned rem ¢
0ld walue:

Hew walue: 4 days
Copying M3F field Task Actual Work to CQ field am actual work
0ld walue:

New walue: 0 hra
Field Owner was changed by the user during export. This data will be
-
3

1 |

Save Log |

10 Check the Show all logged information box at any time during the export
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process if you want to display full details about a task and its values.

You can check or uncheck the Show all logged information box at any time
before or during the export process. When it is checked, the Progress
window will display information on each field in each task being
exported, including the value of the field. When the box is not checked, the
Export New Microsoft Project Plan Tasks To ClearQuest window displays
only the name of the task being copied over to the ClearQuest database.

After the export process is complete, Rational ClearQuest Project Tracker
displays a message advising you to save the changes to the project plan.
Clicking OK will make the changes permanent in the ClearQuest database.
Clicking Cancel will stop the new records from being saved in the
ClearQuest database.

During the Export process, Rational ClearQuest Project Tracker will check
each project plan task to see that the entry in the Resource name field
matches one of the Owner field entries already in use in the ClearQuest
database (the Owner field is also sometimes called the ClearQuest user
field).

If it encounters a Resource name in a project plan task that is not in use in
the ClearQuest database, Rational ClearQuest Project Tracker will
interrupt the export process and display the Select Matching ClearQuest
User window.
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Figure 29 Select Matching ClearQuest User
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If you see an Owner name that is equivalent to the Resource field in the
linked project plan task, select that name from the list and click OK.

For example, if the project plan Resource name is “user,” and you know
that “Associate” is the equivalent Owner name in the ClearQuest
database, select “user” and click OK.

Note that when you click OK, Rational ClearQuest Project Tracker will
take the entry that was in the Owner field of the ClearQuest database
record and replace it into the Resource name field of the project plan task.

In the example above, this means it would place “user” in the Resource
name field of the project plan task you were exporting. This is to make
sure that at the end of the process the Owner field in the database record
and the Resource name field in the project plan task have the same entry.
Rational ClearQuest Project Tracker will also change the Resource name in
the list of valid Resource names to make sure that the same Resource name
(“user™) will be used consistently for future tasks and records in both the
project plan and the ClearQuest database.

If you do not see a matching User name, click Cancel. This will cancel the
exporting of that project plan task. You should then contact your
ClearQuest Administrator to create the correct User name in the
ClearQuest database.

36 Using Rational ClearQuest Project Tracker



12 When you return to the Exporting New Microsoft Project Plan Tasks
window, click Save Log, to save the information in a Rich Text Format
(.rtf) file (see the Viewing and Saving the Log File in Chapter 3, Importing
records from ClearQuest).

13 Click Close when exporting is completed and want to return to your
project plan.

The task you exported will now display a unique CQ Record ID.

Figure 30 CQ Record ID
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Saving a master copy of the project plan

It is strongly recommended that you keep a secure master copy of the last
official version of the Microsoft Project project plan and always use this
master copy for importing, exporting and other Rational ClearQuest Project
Tracker functions.

In some situations, you may want to distribute several copies of the project
plan, perhaps to multiple project managers. However, you can not safely
export records from each of these copies to the ClearQuest database, because
changes in one copy of the project plan may conflict with changes in another
version. The lead project manager must take the responsibility of integrating
changes from all sources into the master copy of the project plan and using
this master copy to export to the ClearQuest database.

The same logic applies to the other functions of Rational ClearQuest Project
Tracker. Keep a secure master copy of the project plan, integrate all changes
into this copy, and make sure that all importing, exporting, updating and
synchronizing are carried out between this version of the project plan and the
ClearQuest database.
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Viewing new records in the ClearQuest database

Additional

Rational ClearQuest Project Tracker will create a new ClearQuest record for
each task and transfer the following fields from the Microsoft Project 2000
task to the record:

Task Name

» Planned Start Date

» Planned Finish Date

*  Planned Work
Actual Work
Remaining Work
Actual Start Date

= Actual Finish Date
Assigned Resource

When Rational ClearQuest Project Tracker finishes exporting the project plan
tasks, the newly created records will be listed in the ClearQuest database.

The planned start and end dates from the project plan task will appear on the
Schedule tab of the ClearQuest form for this record. These fields cannot be
modified by the team member using ClearQuest, because these dates are the
responsibility of the project manager who creates the project plan, not the
team member using ClearQuest.

notes on exporting

Assigning resources

Microsoft Project 2000 allows several resources to be assigned to a task, while
Rational ClearQuest allows only one resource to be assigned. If more than one
resource is listed in the project plan task, Rational ClearQuest Project Tracker
will carry over only the first one.
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Summary tasks and milestones and are not exported

As noted in Chapter 1, Rational ClearQuest Project Tracker does not export
Microsoft Project 2000 summary tasks or milestones. A summary task is a
collection of detail tasks that is used to summarize a phase of a project, but
does not involve work independent of the detail tasks that it summarizes. A
milestone is point that marks a significant event or deadline, but it has neither
work nor duration associated with it. Therefore, Rational ClearQuest Project
Tracker creates ClearQuest database records for detail tasks, but not for
summary tasks or milestones.

Changing field values by owners

After a task has been exported to ClearQuest, some, but not all, of the fields in
the resulting record can be modified by the owner of the record.

The owner is the team member responsible for performing the task. The fields
available for changing are those where the team member is likely to have
correct information, such as the actual start date and the remaining work. The
fields not available for changing are those where the project manager is most
likely to have correct information, such as the planned start and end date.

Entering required fields when the task has no entry

When the field in a task is blank and that field corresponds to a required field
in the ClearQuest database record, Rational ClearQuest Project Tracker will
prompt you for an entry. When you make an entry, that value will be included
in the database record, but the field in the project plan task will still be blank.
If this situation occurs, you may want to run the Update or the Synchronize
function to assure that the task and the record have the same value (the
Update and Synchronize functions are described in Chapter 5, Updating and
Synchronizing).

For example, if the Owner field is blank in the project plan task, during the
Export process you may be prompted to enter a name for this field, because
Owner is a required field in the ClearQuest database record. Your entry will
be included in the new database record created by the Export process, but the
field in the project plan task will remain blank. If you want the project plan
task to include the same information as the database record, you will need to
run the Update or Synchronize function.
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Updating and
Synchronizing

This chapter tells you how to:
Update project plan tasks from linked ClearQuest database records
= Synchronize the project plan and the ClearQuest database.

This chapter outlines the basic steps for updating project plan tasks from
ClearQuest database records, and how to save and view the log files. It
discusses the basic steps for a bi-directional synchronizing of the project plan
and the ClearQuest database.

The chapter then discusses the rules that are used to resolve conflicts that
occur during updates and synchronization, when the same information has
been changed independently in the two systems.

Note that the Update and Synchronize functions do not automatically handle
deleted tasks or records. The issues concerning deletions are discussed in
Chapter 6, Understanding Additional Administrative Procedures.

Synchronizing compared with updating

Synchronizing the project plan with the ClearQuest database is very similar
to updating the project plan. The main difference is that the Update Plan
From ClearQuest function is a one-way transfer of information, with updates
flowing only from the ClearQuest database to the project plan.

Figure 31 The Update Process

Update

Project Plan ClearQuest DB

41



The synchronize process is a two-way transfer of information, with updates
flowing first from the ClearQuest database to the project plan, and then from
the project plan back to the ClearQuest database. In the end, the linked
records and tasks share the same information.

Figure 32 The Synchronize Process
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Updating linked project plan tasks with ClearQuest records

During the life of a project, team members will change information in
ClearQuest database records.

For example, a team member may specify new dates in the actual start and
end date fields provided in the Schedule form of the ClearQuest record.

If the ClearQuest records are already linked to specific tasks in the project
plan, then the Update Plan from ClearQuest function will allow you to
automatically update the linked tasks with the changed information in the
ClearQuest records.

The task fields that will be updated from the ClearQuest record are:
Task Name/Headline
Assigned Resource
Actual Work
Planned Work
Remaining Work
Actual Start Date
Actual Finish Date
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To update the project plan tasks from ClearQuest records:

1
2

Launch Microsoft Project 2000 and open the project plan.

From the Tools>ClearQuest menu, select Update Plan from ClearQuest.
Rational ClearQuest Project Tracker displays the window used for
updating.

Figure 33 The Update Microsoft Project Plan window
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Check the Show all logged information box if you want to display details
about the update any time before or during the update process.

When this box is checked, the Progress window displays information on
each value being updated with new information.When the box is not
checked, the Progress window displays only the name of the task being
updated.

Click Start.

During the Update process, Rational ClearQuest Project Tracker will check
each ClearQuest record to see that the entry in the Owner field (sometimes
called the ClearQuest user field) matches one of the Resource names
already in use in the project plan. If it encounters an Owner name in a
ClearQuest record that is not in use in the project plan, it will interrupt the
update process and display the Select Resource matching CQ user
window.
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Figure 34 Select Matching ClearQuest User window
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If you see a Resource name that is equivalent to the Owner field in the
linked ClearQuest record, select that name from the list and click Change
Resource Name.

If you do not see a matching resource name, you can click Create
Resource, and Rational ClearQuest Project Tracker will fill in the Resource
name field in the project plan task with the entry that is in the Owner field
of the ClearQuest Record.

If you click Create All Resources, then Rational ClearQuest Project
Tracker will automatically fill in the Resource name field with the entry
that is in the Owner field, for all of the other ClearQuest database records
that are being used in the update process. For a more detailed discussion
of these options, see the Matching Resources with ClearQuest Users section in
Chapter 3, Importing Records From ClearQuest.

6 Click Save Log to store the log as a Rich Text Format (.rtf) file after the
update process is completed, if you wish to have a copy of all the
transactions.

You can open the saved .rtf file using any type of text editor or word
processor. (Refer to the Saving and Viewing the Log File discussion in
Chapter 2 for more information.)

7 Click Close when you are finished updating and want to return to the
project plan.
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Synchronizing the project plan with the database

Again during the life of a project, you may be updating the project plan to
respond to changes in requirements, priorities and resources. The Synchronize
Plan with ClearQuest function allows you to convey this changed planning
information to members through Rational ClearQuest Project Tracker.

For example, if revising the project plan changes the Planned Start Date and
Planned End Date for some tasks, the synchronize process will copy those
changes to the appropriate records in the ClearQuest database. When team
members next run a To Do List query against the ClearQuest database, they
will see a list of tasks that have been scheduled for the future, and the records
for those tasks will include the updated planning dates.

Rational ClearQuest Project Tracker will first pull information from linked
ClearQuest database records in order to update the following values in the
project plan tasks:

Task Name/Headline
Assigned Resource
Actual Work

Planned Work
Remaining Work
Actual Start Date
Actual Finish Date
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Rational ClearQuest Project Tracker will then take information from the
following values in the project plan task and use them to update the linked
ClearQuest database records:

Task Name/Headline
Assigned Resource
Planned Start Date

» Planned Finish Date

*  Planned Work
Remaining Work
Planned Duration
Remaining Duration

» Actual Work

= Actual Start Date
Actual Finish Date

Making changes to both ClearQuest and project plan

The Synchronize Plan with ClearQuest function must be used with caution,
because it makes changes to both the ClearQuest database and the project
plan. Once the changes have been saved to the ClearQuest database, you will
need the help of the ClearQuest administrator to make any corrections.

Synchronizing linked tasks and records
To synchronize the ClearQuest database and the project plan:
1 Launch Microsoft Project 2000 and open the project plan.

2 From the Tools>ClearQuest menu, select Synchronize Plan With
ClearQuest.

Rational ClearQuest Project Tracker displays the Synchronize Microsoft
Project Plan Tasks And ClearQuest Records window.

3 Check the Show all logged information box if you want to display details
about the changed values. Again, you can check or uncheck the Show all
logged information box at any time before or during the Synchronize
process.
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4 Click Start.

As each task is synchronized, you will see the log transactions that are
created.

Figure 35 Synchronizing tasks with records
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Matching Resources with CQ Users

During the Synchronize process, Rational ClearQuest Project Tracker twice
compares entries in the Owner field of ClearQuest database records with the
corresponding entries in the Resource name field of the linked Microsoft
Project project plan tasks to make sure they are the same.

This happens first when the Synchronize process pulls modified database
records to update project plan tasks, and again then the process pulls
modified project tasks to update database records.

In the first part of the Synchronize process, Rational ClearQuest Project
Tracker will check each ClearQuest record to see that the entry in the Owner
field (sometimes called the ClearQuest user field) matches one of the
Resource names already in use in the project plan. If it encounters an Owner
name in a ClearQuest record that is not in use in the project plan, it will
interrupt the synchronize process and display the Select Resource matching
CQ user window.
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If you see a Resource name that is equivalent to the Owner field in the linked
ClearQuest record, select that name from the list and click Change Resource
Name.

If you do not see a matching resource name, you can click Create Resource,
and Rational ClearQuest Project Tracker will fill in the Resource name field in
the project plan task with the entry that is in the Owner field of the
ClearQuest Record.

If you click Create All Resources, then Rational ClearQuest Project Tracker
will automatically fill in the Resource name field in the project plan task with
the entry that is in the Owner field for all of the other ClearQuest database
records that are being used in the synchronize process. For a more detailed
discussion of these options, see the Matching Resources with ClearQuest Users
section in Chapter 3, Importing Records From ClearQuest.

During the second part of the Synchronize process, Rational ClearQuest
Project Tracker will check each project plan task to see that the entry in the
Resource name field matches one of the Owner field entries, already in use in
the ClearQuest database. If it encounters a Resource name in a project plan
task that is not in use in the ClearQuest database, it will interrupt the
Synchronize process and display the Select Matching ClearQuest User
window.

Figure 36  Select Matching ClearQuest User window
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If you see an Owner name that is equivalent to the Resource field in the
linked project plan task, select that name from the list and click OK.

Note that when you click OK, Rational ClearQuest Project Tracker will take
the entry that was in the Owner field of the ClearQuest database record and
place that entry back into the Resource name field of the project plan task.
This is to make sure, that at the end of the process, the Owner in the database
and the Resource name in the project plan task have the same entry. Rational
ClearQuest Project Tracker will also change the Resource name in the list of
valid Resource names to make sure that the same Resource name will be used
consistently for future tasks and records in both the project plan and the
ClearQuest database.

If you do not see a matching User name, click Cancel. This will cancel the
synchronizing of that project plan task. You should then contact your
ClearQuest Administrator to create the correct User name in the ClearQuest
database.

Saving and viewing the log file

After the synchronize process is complete, Rational ClearQuest Project
Tracker advises you to save changes to the project plan. Because the changes
to the ClearQuest database have already been committed, you should save the
changes to the project plan. This will ensure that information shared between
the ClearQuest database and the project plan remains consistent.

1 Click OK to save the project plan. The Planning Wizard window then
displays.

2 Inthe Planning Wizard window, check whether you want to save the
project plan with or without a baseline and click Save. The Synchronize
Microsoft Project Plan Tasks With ClearQuest Records window returns.

3 Click Save Log if you want to save the log as a Rich Text Format (.rtf) file.
You can open the saved file using any type of text editor or word
processor.

4 Click Close when you are finished synchronizing and want to return to
the project plan.
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Rules for resolving conflicting information

Sometimes conflicting information will be encountered when updating or
synchronizing the project plan with the ClearQuest database. This occurs
when the same information is changed independently in the two systems. For
example, the project manager might change the start date for a task in
Microsoft Project 2000, while an individual contributor responsible for that
task might enter a different date in the ClearQuest database.

To address this problem, Rational ClearQuest Project Tracker applies a set of
synchronization rules designed to determine the winner based on the who is
most likely to have the best information or make the best decision.

In the example mentioned above, the same information has been changed
independently in Microsoft Project 2000 and in ClearQuest. Because the
individual contributor assigned to the task is in the best position to know the
actual start date, the rule in Rational ClearQuest Project Tracker is that the
contributor's decision wins for this field.

In applying this rule, the Update Plan From ClearQuest function and the
Synchronize Plan with ClearQuest function will copy the Actual Start Date from
the ClearQuest database into the corresponding project plan field.

There are also rules, of course, where the decision of the project manager will
win. For example, because the project manager is responsible for planning,
the Planned Start Date will always come from the entry in the Microsoft
Project task.
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The synchronization rules followed by Rational ClearQuest Project Tracker
are illustrated in the following table. This table indicates which fields can be
updated in Microsoft Project 2000 and in ClearQuest, and which entry is the
winner if there is a conflict.

Field Name ::/I?Qrkc)):olifli?:‘)?decltn gﬁ;bgsgated " "Winner" if conflict
Task Name/Headline Yes Yes ClearQuest
Planned Start Date Yes No -

Planned Finish Date Yes No -

Planned Work Yes Yes ClearQuest
Remaining Work Yes Yes ClearQuest
Planned Duration Yes No -
Remaining Duration Yes No -

Actual Work Yes Yes ClearQuest
Actual Start Date Yes Yes ClearQuest
Actual Finish Date Yes Yes ClearQuest

*The Description field is not changed in the project plan or the ClearQuest
database.

Overriding the synchronization rules

In some cases, you may want to override the synchronization rules applied by
Rational ClearQuest Project Tracker. To do this, you may need to view the log
of the tasks that have been updated or synchronized (see discussion of saving
and viewing logs in Chapter 2), then manually update the affected tasks and
records using Microsoft Project 2000 and ClearQuest.
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Understanding Additional
Administrative
Procedures

This chapter describes a number of administrative procedures you may need
to keep data correctly synchronized between the project plan and the
ClearQuest database, along with additional information that you can use for
troubleshooting.

Using functions together to insure up-to-date information

Updating and synchronizing apply only to linked tasks and
records

It is important to note that the Update and Synchronize functions work only
with tasks that have already been linked to records during an import or
export process. New tasks and new database records (that is, tasks that do not
yet have a linked record, and records that do not yet have a linked task) are
ignored by these functions.

To make sure that a project plan and a ClearQuest database are fully
up-to-date, you may need to use more than one function at a time.

Import and Update to update a project plan

If individual contributors have added new records to the ClearQuest
database, you want them to be transferred to the project plan as new tasks.
However, any records that have been added since the last use of the Import
function will be ignored by the Update and Synchronize functions, because
they have not yet been linked to project plan tasks.

Therefore, to make sure that both new and modified records in the
ClearQuest database are reflected in the project plan, you may need to first
use the Import function to transfer the new records, and then use the Update
function to capture changed information from existing records.
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Export and Synchronize to update a ClearQuest database

If the project manager has added new tasks to the Microsoft Project 2000
project plan, you want these to be transferred to the ClearQuest database as
new records. However, any tasks that have been added since the last use of
the Export function will be ignored by the Synchronize function, because they
have not yet been linked to

a database record.

Therefore, to make sure that both new and modified tasks are reflected in the
ClearQuest database, you may need to use the Export function to transfer the
new tasks, then use the Synchronize function to capture changed information
from existing tasks.

Updating the ClearQuest Record Types List

When records are being imported into Microsoft Project, Rational ClearQuest
Project Tracker checks to make sure that, in the new tasks being created, only
valid ClearQuest record types are inserted in the CQ Type field.

However, during the life of a project the ClearQuest systems administrator
may add new record types to the ClearQuest database and may remove
obsolete ones. If this happens, you need to run the Updating the ClearQuest
Record Types List function.

When you run this function, Rational ClearQuest Project Tracker updates the
ClearQuest Records Type List for that project plan to include new entries on
the list of valid record types.

Alternatively, you can convert the record type for a new task to one of the
types already on the list. However, you must do one or the other or you will
not be allowed to import the record.

To run the Updating the ClearQuest Record Types List utility from the
Tools>ClearQuest menu, select Update ClearQuest Record Types List.
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Deleting Tasks and Records

Deleting a task from the project plan

Great care is required when a task is deleted from the project plan. In some
cases it may be desirable to delete the ClearQuest record that corresponds to
the deleted task. However, in other circumstances it may be preferable to
leave the record in place. Perhaps some work was done on this item even
though it is no longer needed in the project plan, or perhaps the work is being
transferred to another project.

When you delete a task from the project plan, Rational ClearQuest Project
Tracker does not delete the corresponding ClearQuest record. You can leave the
ClearQuest record in the database, or you can remove it manually in
ClearQuest. Whatever choice you make, you must be very careful to track all
of the tasks deleted from the project plan and take the correct action in each
case.

The log created by the Update and Synchronize functions will include a
message that indicates when a linked task can not be found for a ClearQuest
database record. Consult the log to find these messages and make sure that
the appropriate result was achieved.

Deleting arecord from the ClearQuest database

Great care also is required when a record is deleted from the ClearQuest
database. In some cases it may be desirable to delete the project plan task that
corresponds to the deleted record. However, in other circumstances it may be
preferable to leave the task in place.

When you delete a record from the ClearQuest database, Rational ClearQuest
Project Tracker does not delete the corresponding project plan task. You can
leave the task in the project plan, or you can remove it manually in Microsoft
Project 2000. Whatever choice you make, you must be very careful to track all
of the records deleted from the ClearQuest database and take the correct
action in each case.

The log created by the Update and Synchronize functions will include a
message that indicates when a linked ClearQuest database record can not be
found for a task. Consult the log to find these messages and make sure that
the appropriate result was achieved.
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Additional Considerations

Changing required fields in ClearQuest

If the ClearQuest administrator changes the ClearQuest database schema to
add new required fields or make existing fields required, he or she must work
closely with the project manager to make sure that every task in the Microsoft
Project project plan has an entry in this field.

If one of the tasks in the Microsoft Project project plan does not have an entry
in the newly created required field, then that task can not be exported or
synchronized--Rational ClearQuest Project Tracker will display an error
message and fail to export or synchronize that task.

Avoiding nested project plans

Once a project plan has been linked to a ClearQuest database, it is not
possible to nest other project plans within the linked plan. If you do so,
executing the Synchronize function will cause run-time errors and
unpredictable behavior.

Instead of nesting a project inside the linked project, you will need to enter
the new tasks into your linked project.

Task Name may be truncated when transferred to
the ClearQuest Headline field

The ClearQuest Headline field can contain up to 125 characters.

Therefore, if you export a project plan task with a Task Name exceeding 125
characters, only the first 125 will be transferred to the Headline field of the
ClearQuest record (in other words, the field is truncated at 125 characters).
You will be able to see when this occurs in the progress log, which will
display a statement.

Note that if you use the Export function and later the Synchronize function,
you may end up with the 125 character truncated version back in the project
plan Task Name field. This is because the Export function only transfers the
first 125 characters to the Headline field in the ClearQuest record. Then,
during the Synchronize process, the 125 character version is copied back to
the project plan Task Name field, overwriting the longer version.
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Removing an owner from the ClearQuest database

The ClearQuest administrator is able to remove names from the list of active
ClearQuest users (which consists of those user names that are valid entries in
the Owner field of the ClearQuest database).

However, when a name is removed from the list of active ClearQuest users, it
is not removed from the list of ClearQuest users recognized by Rational
ClearQuest Project Tracker during the Import, Export, Update and
Synchronize processes.

This fact can have an impact when Rational ClearQuest Project Tracker,
during one of these processes, finds a Resource name in the project plan that
does not match a recognized ClearQuest owner name. Rational ClearQuest
Project Tracker will then display a list of recognized ClearQuest users.

You can select a name from the list so that the Resource name in the project
plan record will match a recognized ClearQuest user. However, in this case
the list displayed will include the name of the ClearQuest user who was
earlier removed from the list of active users. Selecting this would cause the
name of someone no longer working on the project to be stored in the
Resource name field of the project plan task.

It is therefore important that the ClearQuest administrator notify every
project manager when a ClearQuest user is removed from the active users list.
That way, the project manager knows not to select that user’s name during an
Import, Export, Update or Synchronize process.

Deleting the Actual End Date from a ClearQuest record

A ClearQuest user may modify the Actual End Date field in a ClearQuest
database record to make it blank. However, when you then run the Update or
Synchronize process, that blank is not “copied” into the Actual Finish Date
field in the linked record in the project plan. Instead, whatever date was in the
Actual Finish Date field remains there.

This happens because Microsoft Project does not allow Rational ClearQuest
Project Tracker to “copy” a blank onto an Actual Finish Date field that already
has a value.

To know if there is a blank in the Actual End Date field, you or the ClearQuest
administrator can run a query of the ClearQuest records.
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Setting Up and
Configuring
Rational ClearQuest
Project Tracker

Appendix A describes how to set up Rational ClearQuest Project Tracker in
order to exchange information between Microsoft Project 2000 and
ClearQuest.

Prerequisites

The prerequisites for setting up Rational ClearQuest Project Tracker are:
» ClearQuest has been installed and is in use

= Microsoft Project 2000 has been installed and is in use by the project
manager

In essence, these prerequisites mean that your project team has already
learned how to effectively use both ClearQuest and Microsoft Project 2000,
and that both applications have been deployed on the current project. This
means that there are already ClearQuest records for the project and that there
is a project plan in Microsoft Project with work tasks.

To setup and configure Rational ClearQuest Project Tracker you will need to:

1 Update the ClearQuest database schema for your project — to store the new
information that will be exchanged with Microsoft Project 2000

2 Run Regsvr32 CQMSPInt.dll to finalize the installation.
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In addition, the following steps will need to be taken either by you or by the
project manager responsible for each project plan. These steps are described
in Chapter 2: Linking a Project Plan with a ClearQuest Database. You may want
to work with the project manager or managers to make sure these steps are
carried out correctly:

3 Configure each Microsoft Project 2000 project plan with information about
ClearQuest by providing the following information:

i Which ClearQuest database to exchange data with.

ii  Which Microsoft Project fields to use to store ClearQuest related
data

iii Which ClearQuest record types will be available.

4 Configure the view inside Microsoft Project 2000 to display ClearQuest
related data.

When these steps have been taken, you are ready to do the initial import of
ClearQuest records into Microsoft Project 2000 and the initial export of
Microsoft Project 2000 tasks to ClearQuest.

These steps will be discussed in greater detail.

Platform Dependencies

Rational ClearQuest Project Tracker is implemented as an add-in to Microsoft
Project 2000 that communicates with ClearQuest using COM. This means that
the platforms supported by Rational ClearQuest Project Tracker are defined
by Microsoft Project 2000, or stated differently, this means that Rational
ClearQuest Project Tracker does not depend on the way ClearQuest was
deployed.

The ClearQuest server can be deployed on an NT machine or a Unix machine
using any of the supported ClearQuest databases. All that is required is that
the client machine have the Windows ClearQuest client and Microsoft Project
2000 installed.
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Update the ClearQuest database schema for your project

Rational ClearQuest Project Tracker requires two ClearQuest packages to be
applied to the ClearQuest database schema that is used for your project’s
ClearQuest database. These ClearQuest packages must be installed in the
following order:

1 AMBaseActivity
2 AMWorkActivitySchedule

What are ClearQuest packages?

ClearQuest packages contain definitions of new database fields and related
information that when applied to the definition of a ClearQuest record type
add the new fields to that record type. The ClearQuest packages needed by
Rational ClearQuest Project Tracker define fields such as Planned Start Date
and Actual Work.

For more information on ClearQuest packages, please refer to the
Administering ClearQuest manual and to the online help for the Rational
ClearQuest Designer application.

Note: You will need to apply both, the AMBaseActivity and
AMWorkActivitySchedule packages, to each ClearQuest record type that you
want to use to exchange information with Microsoft Project 2000.
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Record Type(s)

Package Description added/modified Field(s)
AMBaseActivity Provides additional Adds the Main tab to the Fields added to enabled
support for Rational enabled record type. record type:
ClearQuest Project Tracker. Headline
Owner
Description
AMWork Provides scheduling Defines and adds the Fields added to enabled

ActivitySchedule

attributes needed to
integrate Rational
ClearQuest and Microsoft
Project 2000 using Rational

ClearQuest Project Tracker.

With the
AMWorkActivitySchedule
record type family, you can
query records being
created and updated with
Rational

AMSchedule record type
family to the enabled
schema. Record types
being enabled with this
package will be added to
this record type family.

Adds the Schedule tab to
the enabled record type.

AM Schedule record type:
am_planned_start_date

am_planned_end_date
am_planned_work
am_planned_rem_work
am_planned_duration
am_planned_rem_duration
am_actual_start_date
am_actual_end_date

ClearQuest Project Tracker.
am_actual_work

To apply these packages, use the ClearQuest Package Wizard feature in the
ClearQuest Designer application. For more information on the ClearQuest

Package Wizard, please refer to the Administering ClearQuest manual and to
the online help for the Rational ClearQuest Designer application.

Run Regsvr32 CQMSPInt.dll

To finalize Rational ClearQuest Project Tracker’s installation, you need to run
Regsvr32 CQMSPInt.dll on your system. This DLL file is already available in
your system when you installed ClearQuest.

To register the file:
1 From the Start menu, select Run.
2 Inthe Run window, enter Regsvr32 CQMSPInt.dll and click OK.

You are now ready to exchange data between Rational ClearQuest Project
Tracker and Microsoft Project 2000.
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Using RUP Project Plans

The Rational Unified Process (RUP) provides a set of Microsoft Project plans
that organize tasks according to the best practices methodology supported
by RUP.

If you have RUP available on your system, you can access the project plans
from Rational Unified Process>Templates>Microsoft Project.

Figure 37 Using RUP project plans
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Two levels of plans are provided for each iteration in each phase, a summary
template at the workflow detail level, and a more detailed template at the
activity level.

You can use the RUP project plans as a starting point, then adjust and add
detail to reach a complete project plan with the specific tasks that can be
converted to ClearQuest database records and assigned to individual
contributors. For example, you should replace generic resource names with
specific resource names, adjust start and finish dates, add detailed work-level
tasks and remove tasks that do not apply.
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